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Introduction
�  Who Should Read This Guide

�  Related Publications

�  World Wide Web Information

�  Getting Help
.

Who Should Read This Guide
This guide is intended for administrators who are installing or configur-
ing QACenter products; it does not contain reference or usage informa-
tion. You can find that information in the online Help for your product.

Compuware assumes that you are familiar with basic Microsoft Windows 
navigation. If this is not the case, familiarize yourself with the documen-
tation for Microsoft Windows before reading this guide.

Related Publications
The Distributed License Management Installation Guide, which contains 
instructions for licensing your QACenter product, is available in PDF 
format. Access this guide from the Compuware FrontLine Customer 
Support Web site at http://frontline.compuware.com. See “World Wide 
Web Information” on page 8 for specific details.

Because PDF is based on PostScript, a PostScript printer is the most 
reliable way to print online books. In most cases, you can also print PDF 
files to PCL printers. If you cannot print the PDF files to your printer, 
refer to Adobe’s Web site at http://www.adobe.com for troubleshooting 
information.
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World Wide Web Information 
To access Compuware Corporation’s site on the World Wide Web, point 
your browser at http://www.compuware.com. The Compuware site 
provides a variety of product and support information.

FrontLine Support Web Site: You can access online customer support for 
Compuware products via the FrontLine support Web site. FrontLine 
provides fast access to critical information about your QACenter product. 
You can read or download documentation, frequently asked questions, 
and product fixes, or e-mail your questions or comments. To access 
FrontLine, follow these steps:

1 Open a Web browser and go to: http://frontline.compuware.com 
The Welcome to FrontLine page appears.

2 On the right side of the page, enter your login ID and password and 
click Login.

Note: If you are a first-time visitor, click Register to receive your free 
password to access FrontLine. After you complete the registration 
form, your login ID and password will be e-mailed to you and your 
account will be activated.

3 From the list in the center of the page, select a product and click Go. 
You will see the product’s FrontLine home page, where you can 
access documentation, technical information, fixes, and other sup-
port items.

Getting Help
At Compuware, we strive to make our products and documentation the 
best in the industry. Feedback from our customers helps us maintain our 
quality standards. If you need support services, please obtain the follow-
ing information before calling Compuware’s 24-hour product support 
hotline:

� The name, release (version), and build number of the QACenter prod-
uct. This information is displayed when you select the About com-
mand from your product’s Help menu. The name and release are also 
on the covers of the product documentation.

� Installation information, including installed options, whether the 
product uses local or network databases, whether it is installed in the 
default directories, whether it is a client or server installation.

� Environment information, such as the operating system and release 
on which the product is installed, memory, hardware/network speci-
8     QADirector-QACenter Portal Installation and Configuration Guide
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fications, and the names and releases of other applications that were 
running.

� The location of the problem in the QACenter product software, and 
the actions taken before the problem occurred.

� The exact product error message, if any.

� The exact application, licensing, or operating system error messages, 
if any.

� Your Compuware client, office, or site number, if available.

Compuware Customer Support

Compuware Corporation 
One Campus Martius 
Detroit, MI 48226-5099 
1-800-538-7822
 Introduction     9
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Chapter 1

Getting Started
� Overview

� Before You Install

� System Requirements

� Integrated Products Requirements

� Deploying QADirector and QACenter Portal

Overview
QACenter is a suite of automated software quality products for enterprise 
and e-business applications. QACenter offers a comprehensive solution 
for IT organizations concerned with assuring quality and performance, 
while keeping pace with faster development cycles. QACenter includes:

QADirector:  Coordinates the entire testing process by organizing, track-
ing, and executing automated and manual tests. QADirector integrates 
with Compuware’s testing, program analysis, defect tracking, and 
requirements management tools.

QACenter Portal: Provides a comprehensive reporting facility that is 
consistent among the QACenter point products. It enables users, with 
various roles and responsibilities, to create and view detail, summary, and 
cross-product reports. QACenter Portal ties together requirements 
planning, test planning, test execution, and defect tracking to provide 
users with a centralized view of application quality. Integrates with 
Reconcile and QADirector.

QAHiperstation+: Works with mainframe QAHiperstation to test host-
based applications directly from your Windows desktop. This integrated, 
workstation-based interface tool uses 32-bit code that provides improved 
performance and better stability on 32-bit Windows platforms.
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QARun: Tests enterprise client/server applications. QARun creates and 
runs test scripts that support a wide variety of development tools and the 
diverse components of today's corporate environments. QARun couples 
advanced verification facilities with error-recovery mechanisms to 
reliably test local and remote applications. 

Reconcile: Helps create and control project requirements. It stores the 
project requirements in a relational database. You can view the require-
ments through Microsoft Word, a reporting view (grid), and the Web. 
Reconcile integrates with QADirector and TrackRecord. Working 
together, these products help you manage project development from 
conception through delivery.

TestPartner: Tests Web- and Windows-based applications that use 
Microsoft technologies. You can record user sessions with the applica-
tion, add validation functions, and replay the sessions later to ensure 
that the application works as expected. TestPartner’s scripting language is 
Visual Basic for Applications (VBA); it supports testing of Java, Visual 
Basic, and Visual C++ applications; browser-based Web applications; and 
COM components including both ActiveX controls and automation 
objects.

TrackRecord: Records and reports information about products being 
developed or supported. Information on team members, testers, sched-
ules, and defect reports is recorded in an object-oriented database; it can 
be retrieved using TrackRecord's query and reporting features.

WebCheck:  Checks the quality of even the largest Web sites. WebCheck 
automatically scans a Web site for more than 50 potential types of 
problems and provides 19 HTML reports. WebCheck is integrated with 
QARun and QADirector and can be used as a stand-alone product.

In addition to the QADirector suite of products, the QACenter CD 
includes Adobe Acrobat Reader, Microsoft Internet Explorer, Java 2 Devel-
opment Kit, and Microsoft Virtual Machine installation programs. To 
install one or more of these products from the QACenter CD, click Install 
3rd Party Software, then click on the product installation you would 
like to perform.

Before You Install
Review this section before you install QADirector or QACenter Portal.
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Installation Types

The following installation options are available when you install 
QADirector and QACenter Portal: 

Initial Installation: An initial installation is the first-time installation of a 
product on your computer. 

Modify: A modification of the product installation occurs when you add 
or remove one or more of a product’s components, but not all of them. 
See “Modifying an Installation” on page 56 for instructions.

Repair: A repair installation may be necessary due to the corruption of a 
program or the inadvertent deletion of the product. See “Repairing an 
Installation” on page 56 for instructions.

Remove: This option uninstalls all product components. See “Uninstall-
ing QADirector” on page 56 or “Uninstalling QACenter Portal” on page 
57 for instructions.

Release Notes

Review the Release Notes for information about new features, technical 
notes, and known issues that may enhance or impact your product’s 
performance. Release Notes contain recent changes that may not be 
included in your QACenter product documentation. 

View Release Notes from the QACenter product CD or on FrontLine, 
Compuware’s product support Web site. The Release Notes on FrontLine 
are periodically updated as new information becomes available.

Accessing the Release Notes from the QACenter CD

1 Insert the QACenter CD into the CD-ROM drive. If the CD browser 
does not start automatically, navigate to the CD’s root directory and 
run setup.exe.

2 Click View QACenter Release Notes. The Release Notes open in your 
default Web browser.

3 Read the Release Notes online, or print the document.

4 After reading or printing the Release Notes, close the document to 
return to the CD browser.
 Getting Started     13



Accessing the Release Notes on FrontLine

1 Open a Web browser and go to http://frontline.compuware.com 
where the Welcome to FrontLine page appears.

2 On the right side of the page, enter your login ID and password and 
click Login.

Note: If you are a first-time visitor, click Register to receive your free 
password to access FrontLine. After you complete the registration 
form, your login ID and password will be e-mailed to you and your 
account will be activated.

3 From the list in the center of the page, select a product and click Go. 
You will see the product’s FrontLine home page, where you can 
access documentation, technical information, fixes, and other sup-
port items.

System Requirements
QACenter has system requirements for each component. Those require-
ments are listed below.

QADirector Client Machine

Hardware

� Mid-level Pentium III PC with 512 MB of RAM (minimum)

� Minimum 450 MB of free disk space*

Software

� Microsoft Windows 2000 Professional with Service Pack 4, Windows 
2000 Server, Windows XP Professional with Service Packs 1,1a, or 2, 
or Windows Server 2003

� TCP/IP protocol installed on all computers

� Microsoft Internet Explorer 6.0 with Service Pack 1. You can install 
Internet Explorer from the QACenter CD, or allow QADirector to 
install a minimal version.  

� Adobe Acrobat 6.0 or Acrobat Reader (provided on the QACenter CD) 
to view the online books in PDF format
14     QADirector-QACenter Portal Installation and Configuration Guide
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Additional Requirements

� Static IP address or access to a DNS server to resolve workstation 
addresses

� For the manual Web testing feature and reports capabilities, install 
QACenter Portal

� Additional resources may be required for testing tools and the appli-
cation under test

QACenter Portal Client Machine

� Microsoft Internet Explorer 6.0 with Service Pack 1

QADirector/QACenter Portal Database Server

� Microsoft Windows 2000 Server with Service Pack 4, Microsoft Win-
dows 2000 Advanced Server, Microsoft Windows 2000 Professional, 
Microsoft Windows XP Professional with Service Pack 1, 1a, or 2, or 
Microsoft Windows Server 2003 Enterprise, Microsoft Windows 2003 
Standard

One of the following databases:

� Microsoft SQL Server 7.0 with Service Pack 3 or 2000 with Service 
Pack 3 

� Oracle 8.1.7 or 9i

QACenter Portal Web Server

Hardware

� 1 GHz processor with 512 MB RAM (2 GHz with 1 GB RAM recom-
mended)

� Minimum 450 MB of free disk space

Software

� Microsoft Windows 2000 Server with Service Pack 4, Microsoft Win-
dows XP Professional with Service Pack 1, 1a or 2, Microsoft Win-
dows Server 2003 Web, Microsoft Windows Server 2003 Enterprise, 
Microsoft Windows 2003 Standard

� Microsoft Internet Information Server (IIS) 5.0, 5.1, or 6.0

� Microsoft Internet Explorer 6.0 with Service Pack 1
 Getting Started     15



� Adobe Acrobat 6.0 or Acrobat Reader (provided on the QACenter 
product CDs) to view the online books in PDF format

Configuring a QADirector Team Environment
If responsible for configuring QADirector for use in a team environment, 
follow this process for best results:

Note: Ensure that each team member has read/write access to the 
database. 

1 Install QADirector on each team member’s computer.

2 In order to use QADirector in a Windows environment, users must 
have specific permission and rights. Ensure that the users have 
update access to the following registry keys:

� HKEY_CURRENT_USER\Software\

� HKEY_LOCAL_MACHINE\SOFTWARE\

Users must also have update access to the following directories:

� QADirector install directory

� \Program Files\Common Files\Compuware

� System32

3 Choose the database that the team will use to store test suites and job 
results. The database can reside on any computer. Compuware rec-
ommends using SQL Server or Oracle in multi-user environments. 
See “Installing the QACenter Database” on page 21.

4 On each team member’s computer, shut down the Test Management 
Server and the Test Execution Server if they are running. From the 
Login dialog box click the Configure button. See “Installing the 
QACenter Database” on page 21.

5 Choose the QADirector machine that will run the Test Management 
Server. This computer will function as the server for test management 
purposes; all other computers are clients. Ensure the server machine 
is connected to the team database via a valid DSN; then, start the Test 
Management Server on the server machine. See QADirector online 
Help for more information.

6 On each computer, start the Test Execution Server so that jobs can be 
executed on the computer. See QADirector online Help for more 
information.
16     QADirector-QACenter Portal Installation and Configuration Guide



Note: It is possible to set up several Test Management Servers with different 
priorities. The prioritized Test Management Server list appears in the 
TM Server List panel. These Test Management Servers will start 
according to priority and only run on one machine at a time. For 
example, if a Test Management Server with the priority of 1 fails to 
start, the Test Management Server with the priority of 2 will start in 
its place.

Integrated Products Requirements
QADirector and QACenter Portal integrate with many Compuware 
automated testing, analysis, defect tracking, and requirements manage-
ment tools. If you intend to use QADirector or QACenter Portal with any 
of these tools, please note the minimum version requirements:

� File-AID/CS (Compare, Converter) Release 03.00.02 or later 

� QAHiperstation Release 07.03 or later 

� QAHiperstation+ Release 01.00.01 or later (Release 2.0 recommended)

� QALoad Release 05.01 or later

� QARun Release 04.09.01 or later 

� Reconcile 01.00.03 or later

� TestPartner 05.02.01 or later

� TrackRecord Release 06.02 or later

Required: QACenter Portal and QADirector versions must remain on compat-
ible versions. For example, run QADirector 5.0.0 with QACenter 
Portal 5.0.0, or QADirector 5.0.1 with QACenter Portal 5.0.1.

Deploying QADirector and QACenter Portal
The following diagram illustrates the recommended configuration for 
QADirector and QACenter Portal.
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Basic Installation
The following example provides the installation sequence for QACenter 
Portal and QADirector using the default database (MSDE) on one 
machine. 

These instructions describe a basic installation and should not be used in 
place of the complete installation instructions provided in “Installing 
QACenter Portal/QADirector” on page 27. The following instructions 
assume that you have DBA privileges.

Required: If you are working in an enterprise environment, Compuware 
recommends using a separate machine for the Web server and a 
separate machine for the database server.
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1 Install QACenter Portal with MSDE. Refer to “Installing QACenter 
Portal” on page 27. 

2 Install QADirector without database. Refer to “Installing QADirector” 
on page 30.

3 Configure QADirector. Refer to “Configuring QACenter Portal/QADi-
rector” on page 35.

4 Create an ODBC data source name that points to the MSDE database. 
Refer to “Setting Up an ODBC DataSource” on page 65.

To verify the installation:

1 Open QADirector using admin as the user name and admin as the 
password.

2 Create a project called Test1.

3 Open QACenter Portal using admin as the user name and admin as 
the password and verify that the project called Test1 exists.
 Getting Started     19
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Chapter 2

Installing and Creating the  
QADirector/QACenter Portal  
Database on the DB Server 
� About the QADirector/QACenter Portal Database

� Installing the QACenter Database

About the QADirector/QACenter Portal Database
QADirector and QACenter Portal share the same database. A default 
MSDE instance named QACenter is installed with QADirector’s and 
QACenter Portal’s Database Server component, if you select that option. 

If you do not install the default MSDE database instance, you must install 
and create a SQL Server, or Oracle database. If you and your colleagues 
need to share test data, keep in mind the following:

� Designate one copy of the database instance to use as the team data-
base. Each team member must create an ODBC data source name that 
points to the team database and then connect to the database. See 
the QADirector online Help for more information. 

� Create a new Oracle or SQL Server database to use as the team data-
base. The following sections in this chapter describe the requirements 
and procedures for creating a new database.

Installing the QACenter Database
There are two different ways to create the database: with the installation 
CD or manually. Manually creating and configuring a database consists 
of a series of procedures. To simplify this process, Compuware provides 
an installation directly from the product CD. 
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This section provides information about installing a QACenter SQL 
Server or Oracle database. To manually create and configure the database, 
refer to “Manually Creating and Configuring a Database” on page 59.

Note: Use the database installation from the CD if you have no database 
administration experience. 

SQL Server Requirements

� An existing database server that runs a supported version of SQL 
Server. Refer to “System Requirements” on page 14 for details.

� A database instance on the SQL Server database server to hold QADi-
rector data. Use the following specifics to configure the database 
instance:

� SQL Server must be case insensitive at the time of the SQL Server 
installation.

� If the database instance is defined, you must specify code page 
1252 and sort order 52 (also known as ISO 8859-1). 

� If you are using SQL Server 2000, specify the 
SQL_Latin1_General_CP1_C1_AS collation.

� A SQL Server user ID and password to allow the QADirector adminis-
trator to set up the database server. 

Installing the QACenter SQL Server Database

To install the QACenter SQL Server database:

1 Refer to “SQL Server Requirements” on page 22 for SQL Server 
requirements.

2 Log on as a user with administrator permissions. 

3 Insert the QACenter CD into the CD-ROM drive. The QACenter CD 
browser should automatically appear. If it does not, navigate to the 
root directory and run the setup.exe file.

4 Click Install QACenter Products.

5 Click Run QACenter Database Installation. The Welcome dialog 
box appears.

6 Read the welcome screen and click Next. The License Agreement 
dialog box appears. 
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7 Read the license agreement and click Yes to accept the terms of the 
agreement. The Database Management System dialog box appears.

8  Select Microsoft SQL Server 7.0 or 2000 and click Next. The SQL 
Server Login Information dialog box appears.

9 Type the database server name in the Server field.

10 Type a database user name in the Login field. This user must have 
sufficient permissions to create a database. Example: sa.

11 Type the user password in the Password field.

12 Click Next. The Database Selection dialog box appears.

13 Select the QADirector database to install and deselect Reconcile.

14 Click Next. The Database Information dialog box appears.

15 Type a name for the new database in the Database field.

16 Optionally, type a user name to be attached to the new database in 
the Login field. The database installation process will create a new 
user account.

17 Optionally, type a password for the new user in the Password field.

18 Click Next. The Review Settings dialog box appears. 

The Review Settings dialog box displays a summary for the informa-
tion specified in the previous setup screens. To change anything, 
click Back.

19 Click Next to begin creating the database. The Command Results 
dialog box appears.

At the end of the installation, this dialog box displays a log contain-
ing all commands that were executed during the database creation. 
To save the log, select the text. Then copy and paste this information 
into a text file. 

Note: Compuware recommends saving the log file.

20 Click Finish to complete the database installation.

Oracle Server Requirements

� An existing database server that runs the supported versions of Ora-
cle. Refer to “System Requirements” on page 14 for details.

� A database instance set up on the Oracle database server to hold 
QADirector data. Use the following specifics to configure the data-
base instance:
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� When the Oracle database instance is defined, you must specify 
the Storage Character Set as iso 8859-1 West European. 

� The NLS_LANGUAGE parameter should be set in the parameter file 
as:

NLS_LANGUAGE = 'AMERICAN'

If you are using Windows 2000, set the NLS_LANGUAGE 
parameter to AMERICAN_AMERICA.WE8ISO8859P1 in the 
following locations:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES\IDO\NLS_LANG
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME-\NLS_LANG

� An Oracle user ID and password to allow the QADirector adminis-
trator to set up the Oracle database server.

Installing the QACenter Oracle Database

To install the QACenter Oracle database:

Required: You must have an Oracle Net Service created before installing an 
Oracle database.

1 Refer to “Oracle Server Requirements” on page 23 for Oracle require-
ments.

2 Log on as a user with administrator permissions. 

3 Insert the QACenter CD into the CD-ROM drive. The QACenter CD 
browser should automatically appear. If it does not, navigate to the 
root directory and run the setup.exe file.

4 Click Install QACenter Products.

5 Click Run QACenter Database Installation. The Welcome dialog 
box appears.

6 Read the welcome screen and click Next. The License Agreement 
dialog box appears. 

7 Read the license agreement and click Yes to accept the terms of the 
agreement. The Database Management System dialog box appears.

8 Select Oracle 8.1.7 or 9i and click Next. The Oracle Login Informa-
tion dialog box appears.

9 Type the service name in the Service field.
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10 Type a user/schema name in the Name field. This user must have suf-
ficient permissions to create a user/schema. Example: sys.

11 Type the user password in the Password field.

12 Click Next. The Database Selection dialog box appears.

13 Select the QADirector database and deselect Reconcile.

14 Click Next.The Database Information dialog box appears.

15 Type a user name to be attached to the new database in the Name 
field. The database installation process will create a new user account. 
A schema with this name is also created. 

16 Type a password for the new user name in the Password field.

17 Click Next. The Review Settings dialog box appears. 

The Review Settings dialog box displays a summary for the informa-
tion specified in the previous setup screens. To change anything, 
click Back.

18 Click Next to begin creating the database. The Command Results 
dialog box appears.

At the end of the installation, this dialog box displays a log contain-
ing all commands that were executed during the database creation. 
To save the log, select the text. Then copy and paste this information 
into a text file. 

Note: Compuware recommends saving the log file.

19 Click Finish to complete the database installation.
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Chapter 3

Installing QACenter Portal/
QADirector
� Installing QACenter Portal

� Installing TrackRecord on the Web Server

� Installing QADirector

Installing QACenter Portal
This section explains the installation process for QACenter Portal. Please 
review the “System Requirements” on page 14 to ensure that QACenter 
Portal will install and operate properly on your computer.

Required: Compuware recommends that you exit all non-essential Windows 
programs before running this setup program. Some Windows 
programs may interfere with the installation process. 
 
Previous versions of QACenter Portal: If a previous version of 
QACenter Portal is installed on your computer, Compuware recom-
mends that you uninstall it before installing the new version. 
Failure to do so may cause problems. 

Installing QACenter Portal on the Web Server

If you have a previous version of OptimalView installed, uninstall it 
using the Add/Remove Programs utility.

Installing QACenter Portal on the Web Server

To install the QACenter Portal application on the Web server:
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1 Read the QACenter Portal Release Notes. Release Notes are available 
on the QACenter product CD or on FrontLine, Compuware’s product 
support Web site. See “Accessing the Release Notes on FrontLine” on 
page 14 for details.

2 Log on as a user with administrator permissions. 

3 Insert the QACenter CD into the CD-ROM drive. The QACenter CD 
browser should automatically appear. If it does not, navigate to the 
root directory and run the setup.exe file.

4 Click Install QACenter Products.

5 Click Install QACenter Portal. The Welcome dialog box appears.

6 Read the welcome screen and click Next. The License Agreement 
dialog box appears. 

7 Read the license agreement and click Yes to accept the terms of the 
agreement. The Customer Information dialog box appears.

8 Type your name and company in the User Name and Company 
Name fields. Click Next. The Choose Destination Location dialog 
box appears.

9 Select a location for the QACenter Portal installation. 

� By default, QACenter Portal installs in the folder  
x:\Program Files\Compuware\QACenter Portal 
where x is the drive where Windows resides on your computer.

� To specify a different path, click Browse and select an existing 
folder or type the path name in the Path field. Click OK.

10 A dialog appears asking if you want to install MSDE:

� Click Yes to install the default QACenter database. The Choose 
Database Location screen appears and includes a default loca-
tion. 

� Click No if you are working in a team environment and will use a 
SQL Server or Oracle database.

11 Click Next. The components will install and dialogs will appear noti-
fying you of each installation. 

12 Specify a location for the QACenter Portal program shortcuts. You 
may type a new folder name, or select one from the existing folders 
list. Click Next. The Start Copying Files dialog box appears.
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13 Review the summary of settings that you specified and click Next to 
start copying the program files. The Setup Status dialog box displays 
the progress of the installation.

14 After the installation completes, the Setup Complete dialog box 
appears. Depending on the circumstances, you will see one of the fol-
lowing dialog boxes:

� Display Release Notes: Select this check box to review the infor-
mation in the Release Notes file. This file contains information 
about new features, technical notes, and known issues that may 
enhance or impact QACenter Portal’s performance. Release Notes 
contain recent changes that may not be included in your 
QACenter Portal product documentation.

� Restart Your Computer: You may be prompted to restart your 
computer. If you are prompted to restart your computer, you may 
choose to restart it now (recommended) or to restart it later.

15 Click Finish to complete the installation of QACenter Portal.

Configuring Windows Permissions for QACenter Portal on 
Non-English Operating Systems

Configure the following directories to allow permissions to the Everyone 
user. In non-English versions of Windows, use the language equivalent of 
the English “Everyone”.

� \QACenter Portal\UI\qacenterportal\temp\imports

� \QACenter Portal\UI\qacenterportal\temp\upload\

� \QACenter Portal\planning\templates

Repeat these steps for each directory:

1 Right-click the appropriate directory.

2 Select Properties from the menu. The Properties dialog box appears.

3 Click the Security tab.

4 Click Add. The Select Users dialog box appears.

5 Type Everyone or the language equivalent in the Users field. For 
example, in the German version of Windows, type Jeder.

6 Click OK.

7 Select Everyone or the language equivalent from the Group or User 
Names list.

8 Check Full Control in the Allow column of the Permissions for list.
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9 Click OK.

Installing TrackRecord on the Web Server
If you purchased TrackRecord and want to install it using the Web server 
option from the QACenter CD. For more information, please refer to the 
TrackRecord Installation and Configuration Guide. 

Installing QADirector
This section explains the installation process for QADirector. Please 
review “System Requirements” on page 14 to ensure that QADirector will 
install and operate properly on your computer.

Required: Exiting programs: Compuware recommends that you exit all 
non-essential Windows programs before running this setup 
program. Some Windows programs may interfere with the installa-
tion process. 
 
Previous versions of QADirector: If QADirector version 4.5.1 or 
earlier is installed on your computer, or if you have any beta 
version installed, Compuware recommends that you back up your 
data and uninstall QADirector before installing the new version. 
Failure to do so may cause problems. 
 
Open ports: Ensure that four ports out of ports 1024 through 
5000 remain open. QADirector randomly selects four ports to use 
when executing jobs. 

To install QADirector:

1 Read the QADirector Release Notes. Release Notes are available on the 
QACenter product CD or on FrontLine, Compuware’s product sup-
port Web site. See “Accessing the Release Notes on FrontLine” on 
page 14 for details.

2 Log on as a user with administrator permissions. 

3 Insert the QACenter CD into the CD-ROM drive. The QACenter CD 
browser should automatically appear. If it does not, navigate to the 
root directory and run the setup.exe file.

4 Click Install QACenter Products.

5 Click Install QADirector. The Welcome dialog box appears.
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6 Read the welcome screen and click Next. The License Agreement 
dialog box appears. 

7 Read the license agreement and click Yes to accept the terms of the 
agreement. The Customer Information dialog box appears.

8 Type your name and company in the User Name and Company 
Name fields. Click Next. The Choose Destination Location dialog 
box appears.

9 Select a location for the QADirector installation: 

� By default, QADirector installs in the folder  
x:\Program Files\Compuware\QADirector 
where x is the drive where Windows resides on your computer.

� To specify a different path, click Browse and select an existing 
folder or type the path name in the Path field. Click OK.

10 Click Next. The Select Components dialog box appears. This dialog 
box allows you to select or clear components for installation. High-
light a component to view a brief description.

11 Decide which of the components to install:

� Database Server: Installs an instance of the Microsoft SQL Server 
Desktop Engine (MSDE) on the local machine. A database is cre-
ated within this instance. Windows Client is automatically 
installed.

Note: Select this option only if you want to install the default QACenter 
database. Do not select this option if you are working in a team 
environment and will use a SQL Server or Oracle database.

� Test Management Server: Installs the Test Management Server 
on the local machine. The Test Management Server reads job sub-
missions from the database, manages jobs, tracks the machines 
available for test execution, and manages the licenses used for 
manual test Web execution. It also reports on the status of jobs in 
progress. Refer to the online help for more information.

� Test Execution Server: Installs the Test Execution Server on the 
local machine. The Test Execution Server allows jobs to run on a 
computer. Refer to the online help for more information. 
� If installing only the Test Management Server, or the Test 

Execution Server, configure a database by clicking 
Start>Programs>Compuware>QADirector>DB 
Configuration Utility. The Select a Database dialog box 
appears. 
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� Windows Client: Installs the QADirector application on the local 
machine.

� IBM S/390 Support: Includes the QA 3270 Emulator Server, a 
utility program used to manage communications between your 
3270 IBM mainframe emulator and QADirector. The QA 3270 
Emulator Server includes the TN3270 Mainframe Emulator, a free 
emulator you can use for mainframe testing. If you prefer to use 
your own emulator, refer to the QA 3270 Emulator Server 
Readme file for a list of supported emulators. After installing 
QADirector, you can view the Readme file by clicking Start>Pro-
grams>Compuware>QADirector>QA 3270 Emulator 
Server>Readme.

12 Choose an option and click Next. If the Database Server was selected, 
the Choose Database Location dialog box appears. 

13 Specify a location for the database. You may type a new folder name, 
or select one from the existing folders list. Click Next. The Select 
Program Folder dialog box appears.

14 Specify a location for the QADirector program shortcuts. You may 
type a new folder name, or select one from the existing folders list. 
Click Next. The Start Copying Files dialog box appears.

15 Review the summary of settings that you specified and click Next to 
start copying the program files. The Setup Status dialog box displays 
the progress of the installation.

16 After the installation completes, the Setup Complete dialog box 
appears. Depending on the circumstances, you will see one or both of 
the following dialog boxes:

� Display Release Notes: Select this check box to review the infor-
mation in the Release Notes file. This file contains information 
about new features, technical notes, and known issues that may 
enhance or impact QADirector’s performance. Release Notes con-
tain recent changes that may not be included in your QADirector 
product documentation.

� Restart Your Computer: You may be prompted to restart your 
computer. If you are prompted to restart your computer, you may 
choose to restart it now (recommended) or to restart it later.

17 Click Finish to complete the installation of QADirector.
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Where To Go Next

� The trial license supplied with your QACenter product allows you to 
install the product and run it for a specific time period without first 
installing a license. During this trial period, you will be informed of 
how much evaluation time remains. 

At any time during the evaluation period, you can obtain and install 
a permanent license. When the evaluation period expires, you must 
obtain a license and install it before you can successfully run this 
product. See the Distributed License Management Installation Guide for 
instructions on installing a license. To access this online book, click 
Start>Programs>Compuware>QADirector/QACenter 
Portal>Documentation.

� If you need to configure QADirector for a team environment, proceed 
to “Additional Requirements” on page 15.

� If you installed the optional IBM S/390 Support component, you may 
need to configure the QA 3270 Emulator Server to work with your 
mainframe emulator. Refer to the QA 3270 Emulator Server readme 
file for a list of supported emulators, version requirements, and con-
figuration instructions. To view the readme file, click Start>Pro-
grams>Compuware>QADirector>QA 3270 Emulator 
Server>Readme. 

� If you are ready to begin using QADirector, refer to the QADirector 
online Help. 

� If you intend to complete the QADirector tutorial, you must install 
QARun. After installing QARun, use QARun’s Database Maintenance 
Utility to upgrade the tutorial database that was installed with QADi-
rector. The tutorial database is located in Program Files\Compu-
ware\QADirector\Tutorial\MIBQADB\QAD4.MDB. For detailed 
instructions, refer to the QADirector Tutorial, which can be accessed 
through online Help. 

� For information about modifying, repairing, or removing your QADi-
rector installation, see “Maintaining the Installation” on page 55.
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Chapter 4

Configuring QACenter Portal/
QADirector
� Configuring QACenter Portal on the Web Server

� Configuring IIS on a Windows 2003 Server

� Configuring OptimalView for Load Handling on the Web 
Server (Optional)

� Configuring QADirector Client

� Configuring the Windows XP SP2 Firewall for QADirector

Configuring QACenter Portal on the Web Server
Once the QACenter Portal application and database are installed, the 
portal must be configured to communicate with the database.

Configuring QACenter Portal for Oracle

To configure QACenter Portal for Oracle on the Web server:

1 Open Oracle’s Net Configuration Assistant Utility and create a ser-
vice entry for the database. Refer to “Setting Up an ODBC Data-
Source” on page 65.

1 Open the Windows ODBC Data Source Administrator. Refer to “Set-
ting Up an ODBC DataSource” on page 65.

2 Create a System DSN with exactly the same name as the Net Service 
Name created in step 1. 

Note: Compuware recommends that you use the Oracle driver instead of 
the Microsoft driver when connecting to the QACenter Portal 
database.
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3 Run the Database Configuration Utility located in Start>Pro-
grams>Compuware >QACenter Portal>Database Configuration 
Utility.

4 Select Oracle from the Database options.

5 Type the server name in the Server Name field.

6 Type the database instance in the Database Name field.

7 Type the DSN created in step 2 in the DSN/Service Name field.

8 Enter a port value in the Port field. The default value is 1521.

9 Type the user ID in the User ID field.

10 Type the user password in the Password field.

11 Click Test to validate the configuration. The Test Status dialog box 
appears.

12 If the test is successful click OK.

13 Click OK to exit the configuration utility.

14 If using the Oracle 9.2 Client:

a Locate Ora92 folder in the Oracle installation directory.

b Right-click on Ora92 and select Properties. The Properties dialog 
box appears.

c Click Security.

d Click Add. The Select Users or Groups dialog box appears.

e Add the following users with full permissions: IWAM_<Machine-
Name>, IUSR_<MachineName>, ASPNET, and Everyone.

f Click OK.

g Select the Allow inheritable permissions from parent to propa-
gate to this object.

h Click OK.

Configuring QACenter Portal for SQL Server

To configure QACenter Portal for SQL Server on the Web server:

Note: The port number is used only by the QACenter Portal framework, for 
example, OptimalView. It is not used in configuring or testing the 
QACenter Portal database connection.
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1 Run the Database Configuration Utility located in Start>Pro-
grams>Compuware>QACenter Portal>Database Configuration 
Utility.

2 Select SQL Server from the Database options. 

Note: The DSN server name defaults to QACenter Portal. This is a fixed 
value and cannot be changed.

3 Type the server name in the Server Name field.

4 Type the database name in the Database Name field.

5 Enter a port value in the Port field. The default value is 1433.

6 Type the user ID in the User ID field.

7 Type the user password in the Password field.

8 Click Test to validate the configuration. The Test Status dialog box 
appears.

9 If the test is successful click OK.

10 Click OK to exit the configuration utility.

Disconnecting from the Database

Only one Web server can access the database at a time. In order to 
connect to another database or to access an existing database from a 
different Web server machine, disconnect the Web server from the 
current database.

To disconnect from a SQL or Oracle database:

1 Run the Database Configuration Utility located in Start>Pro-
grams>Compuware>QACenter Portal>Database Configuration 
Utility.

2 Click Disconnect.

3 Click Cancel.

Testing the Oracle Database Connection

After opening QACenter Portal, test the Oracle connection if you are 
using an Oracle database.

To test the Oracle database connection:

1 Open the project called Test1 and navigate to the Requirements 
Planning page.

2 Click the Summary tab.
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If you receive an exception, fix the database configuration. One possible 
cause for the exception is not using the same name for the Windows DSN 
name and the Oracle Service name.

Configuring IIS on a Windows 2003 Server
Windows 2003 requires additional steps in order to use the Internet 
Information Service (IIS) Web server with QACenter Portal.

To configure IIS on the Windows 2003 server:

1 Open the Internet Information Service Manager. For more informa-
tion, refer to the Microsoft Windows documentation.

2 Select the Web Service Extensions option.

3 Select Allow from the All Unknown ISAPI extensions list.

4 If the ASP.NET v1.1.4322 option exists, select Allow.

5 If ASP.NET v1.1.4322 option does not exist:

a Open the Windows Add/Remove Programs utility.

b Click Add/Remove Windows Components. The Windows Com-
ponent Wizard opens.

c Select Application Servers from the Components list and click 
Details.

d Select ASP.NET from the Subcomponents list and click OK.

e Click Next.

f Open Internet Information Service Manager.

g Select Web Service Extensions option.

h Select Allow for ASP.NET v1.1.4322 option.

6 From the Internet Information Service Manager, click Websites and 
Properties.

7 Select the Service tab.

8 Select the Run WWW Service in IIS 5.0 isolation mode option.

9 Click OK.
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Configuring OptimalView for Load Handling on the Web Server 
(Optional)

To improve the performance when there are numerous concurrent users, 
configure the following settings according to the user load:

1 Open optimalview\tomcat\conf\server.xml.

2 Change the number of the following areas for the <Connector class-
Name="org.apache.coyote.tomcat4.CoyoteConnector" according 
to the number of users working concurrently:

� minProcessors: The minimum number of threads that the server 
will attempt to maintain.

� maxProcessors: The maximum number of threads that are avail-
able to perform the requested processing. This is also the limit of 
the maximum number of concurrent clients.

� acceptCount: The maximum queue length for incoming connec-
tions requests when all possible requests processing threads are in 
use. Any requests received when the queue is full will be refused.

For example:

<Connector className="org.apache.coyote.tomcat4.CoyoteCon-
nector"

port="8009" minProcessors="100" maxProcessors="200"

enableLookups="true" redirectPort="8443"

acceptCount="300" debug="0" connectionTimeout="20000"

useURIValidationHack="false"

protocolHandlerClassName="org.apache.jk.server.JkCoyote-
Handler"/>

3 Save the changes and close the file.

4 If using Microsoft SQL Server, open optimalview\tom-
cat\webapps\optimalview\WEB-INF\ovMSSQL.properties. If 
using Oracle, open optimalview\tomcat\webapps\optimal-
view\WEB-INF\ovORACLE.properties.

5 Change the number of the following areas according to the number 
of users working concurrently on the server:

� JDBCMAXPOOL: The maximum number of connections Opti-
malView will attempt to open. Lowering the maximum connec-
tion number will increase the response time of OptimalView 
when the load is high.

� JDBCMINPOOL: The minimum number of connections Opti-
malView will maintain when the load is not high.
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For Example:

JDBCMAXPOOL=120

JDBCMINPOOL=50

6 Save the changes and close the file.

7 Restart the OptimalView service named OptimalView Server.

 Configuring QADirector Client

Connecting to the SQL Server Database

You must have the QADirector workstation set up as a SQL Server client. 
The workstation should be able to connect and communicate with the 
SQL Server database server. The following SQL Server components must 
be installed and configured on the workstation:

� The SQLSRV32.DLL driver provided with the MDAC installation.

To connect to a new or existing ODBC data source on each computer 
where QADirector is installed, access the Select a Database dialog box 
and enter the appropriate information. Access this dialog box from the 
Configure button on the QADirector Login dialog box or from the 
System Administration Center within QADirector. Shut down the Test 
Management Server and the Test Execution Server if they are running on 
the computer.

To connect to the database before logging in to QADirector, follow these 
steps:

1 Create an ODBC DSN. See “Setting up an ODBC Data Source for SQL 
Server” on page 60. 

2 At the QADirector login screen click Configure. The Select Database 
Connection dialog box appears.

3 Select SQL Server / MSDE.

4 Click the list and select the data source name.

5 Enter the database name, schema name, and the SQL Server database 
user name and password.

6 Click OK. If you receive an error message, verify that you entered the 
correct login name and password.

To connect to the database from within QADirector, follow these steps:
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1 Go to the System Administration Center.

2 From the Datasource panel click Actions>Change. The Select Data-
base Connection dialog box appears.

3 Select SQL Server / MSDE.

4 Click the list and select the data source name.

5 Enter the database name, schema name, and the SQL Server database 
user name and password.

6 Click OK. If you receive an error message, verify that you entered the 
correct login name and password.

7 To configure QACenter Portal with the SQL Server database, refer to 
“Configuring QACenter Portal for SQL Server” on page 36.

Connecting to the Oracle Database

You must have the QADirector workstation set up as an Oracle client. The 
workstation should be able to connect and communicate with the Oracle 
database server. The following components of the Oracle client must be 
installed and configured on the workstation:

� Appropriate SQL*Net Client:

� The SQL*Net connect string alias establishes the connection to the 
QADirector database instance on the Oracle database server.

To connect to a new or existing ODBC data source on each computer 
where QADirector is installed, access the Select a Database dialog box 
and enter the appropriate information. Access this dialog box from the 
Configure button on the QADirector Login dialog box or from the 
System Administration Center within QADirector. Be sure to shut down 
the Test Management Server and the Test Execution Server if they are 
running on the computer.

To connect to the database before logging in to QADirector, follow these 
steps:

1 Create an Oracle Net Service name. Refer to “Setting Up an ODBC 
DataSource” on page 65.

2 Create an ODBC DSN. Refer to “Setting Up an ODBC DataSource” on 
page 65.

3 At the QADirector login screen click Configure. The Select a Data-
base dialog box appears.

4 Select Oracle.
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5 Click the list and select the data source name.

6 Enter the schema name and the Oracle database user name and pass-
word.

7 Click OK. If you receive an error message, verify that you entered the 
correct login name and password. 

To connect to the database from within QADirector, follow these steps:

1 Go to the System Administration Center. 

2 From the Datasource panel click Actions>Change. The Select a 
Database dialog box appears.

3 Select Oracle.

4 Click the list and select the data source name.

5 Enter the schema name and the Oracle database user name and pass-
word.

6 Click OK. If you receive an error message, verify that you entered the 
correct login name and password.

7 To configure QACenter Portal with the Oracle database, refer to 
“Configuring QACenter Portal for Oracle” on page 35.

Configuring the Windows XP SP2 Firewall for QADirector 
In Windows XP, Microsoft introduced a set of security technologies to 
improve the ability of Windows XP-based computers to withstand 
malicious attacks from viruses and worms. The Windows Firewall 
prevents unsolicited inbound TCP/IP connections. Therefore, the Test 
Management Server, Test Execution Server and various other test execu-
tion components do not communicate with each other while the 
Windows Firewall is active. 

Use this process in conjunction with Microsoft Windows XP Service Pack 
2 to ensure that QADirector 05.00 works properly when the Windows 
Firewall is active:

1 Click Start > Control Panel > Windows Firewall

The Windows Firewall dialog box appears.
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2 Click the Exceptions tab.
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3 Click Add Program. The Add a Program dialog box appears.

4 Browse to the directory where QADirector is installed.

5 Choose the following programs from the list: 

"QC_TESRV.EXE, QC_TMSRV.EXE, TDRV.EXE 

"TENG.EXE 

If necessary, choose the programs one at a time. It may be necessary to go 
back to the Exceptions tab each time a program is selected. After the files 
are selected, the following appears on the Exceptions tab.

Make sure the checkbox is selected for each of the QADirector programs. 

Obtaining the Correct Port Number

The correct port number must be used for SQL Server to properly set up 
the Firewall. The following explains how to find the correct port number. 
After the port number is obtained, you will return to the Exceptions tab 
to complete the setup.

To get the port number follow these steps:

1 Click Start > Programs > MicroSoft SQL Server > Server Network 
Utility.

The SQL Server Network Utility dialog box appears:
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2 Choose TCP/IP and click Properties. The Properties dialog box 
appears.

The default port number is displayed in the Default port field. 

3 Return to the Firewall dialog and select the Exceptions tab. 

4 Click Add Port. The Add a Port dialog box appears.
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5 In the Port number field, type the port number from the SQL Server 
Network Utility. 

6 In the Name field, type a meaningful name. 

7 Choose the TCP option. 

8 Click OK. The Windows Firewall dialog box appears.

9  Click OK.
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Additional Considerations

� Configure networking to use the TCP/IP protocol with a static port of 
1433.

� By default, SQL Server allows network connections using port 1433. 

� The SQL Server machine should have the latest MS Data Access Com-
ponents (MDAC2.71a). This is available with SQL Server Service Pack 
3a. Without this version of MDAC, it is not possible to connect to the 
SQL Server 2000 installed on a Windows XP with Service Pack 2 oper-
ating system.

� By default the Web Server (IIS) Port 80 is blocked. Enable the port 
using the Windows Firewall dialog box. 
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Chapter 5

Migrating and Upgrading 
Previous Versions of QADirector 
and QACenter Portal

� Migrating QADirector

� Migrating from an Access Database to an
 MSDE Database

� Migrating QACenter Portal

Migrating QADirector
When upgrading from QADirector 05.00 to QADirector 05.00.01, keep in 
mind the following:

Configuring Database Connection:   When configuring the database 
connection for QADirector, enter DEFAULT in the Database Name field 
and in the Schema / Owner Name field. This will ensure a proper 
database upgrade from QADirector 05.00 to 05.00.01.

When upgrading from QADirector 4.5.1 to QADirector 05.00.01, keep in 
mind the following:

User Defined Tools:  All user-defined tools will be removed when you 
uninstall QADirector 4.5.1. Manually recreate them in QADirector 
05.00.01. 

Test Servers:  Make sure the Test Management Server and the Test Execu-
tion Server are shut down. If necessary, stop or shut them down. 

Suites:  Each suite from QADirector 4.5.1 will be placed in its own project 
of the same name in QADirector 05.00.01. QADirector 04.04 suites and 
earlier must be upgraded to 4.5.1 for use with 05.00.01. All users who 
have access to a suite will be added as testers to the project.

Permissions and Passwords:  All user names over 50 characters will be 
truncated. Spaces will be replaced with underscores. QADirector 05.00.01 
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does not allow user names over 50 characters. Passwords with fewer than 
five characters will be replaced with the word "qadirector."

Scripts: Any user-defined scripts with duplicate names will be renamed 
with the original name plus the test ID#. This occurs because all user-
defined script names must be unique in QADirector 05.00.01. If a differ-
ent naming convention is preferred, change all user-defined script 
names, as well as data, before uninstalling QADirector 4.5.1 and upgrad-
ing the database.

Databases:  

Note: Make a backup of the 4.5.1 database in the relevant DBMS (SQL 
Server or Oracle) before migrating.

� Create an ODBC connection to the new database on the machine 
where the migration will be performed (machine must have the cur-
rent QADirector 05.00.01 release). Specify the desired database as the 
default database in the ODBC setup. 

� When migrating from Microsoft Access to MSDE/SQL Server, the 
4.5.1 database cannot be used. A new blank MSDE/SQL Server data-
base must be created. Therefore, ODBC connections are needed for 
both the 4.5.1 Access database and the new 05.00.01 MSDE/SQL 
Server database. MSDE/SQL Server must be installed on the machine 
where the new database will be created.

� The database login/user used during the migration process must have 
the proper settings. In SQL Server and MSDE, the database login 
should have privileges for the database being migrated (or for 
Access>MSDE, for the new MSDE database). This login should have 
"System Administrators" server role and "public" and "db_owner" 
database roles. The default database for this login should be the data-
base being migrated. Note that the login may have access to several 
databases. 

Note: The Test button on the Configuration screen does not work when 
QADirector is pointing to a 4.5.1 database. However, the migration 
can still execute successfully in spite of this. The Test button works 
fine when pointing to a 05.00.01 database.

Filters: Filter field names have changed in 05.00.01 and some of the fields 
from 4.5.1 no longer have a counterpart field in 05.00.01. The fields that 
do not have a counterpart will remain intact in the Filter definitions. In 
order for the Filters to function properly in 05.00.01, you may need to 
update your Filters to remove these fields.

The following is a list of the filter fields in 4.5.1 and their counterpart 
fields in 05.00.01. These fields will be upgraded to the 05.00.01 format:
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Migrating from an Access Database to an MSDE Database
QADirector 05.00 and 05.00.01 do not support Microsoft Access. If Access 
is the current database, migrate it to an MSDE database with the upgrade 
utility. 

If the schema of the QADirector database is older than the client, the 
following message appears:

Current version of QADirector has schema version x whereas required 
schema version is x. Would you like to upgrade QADirector database 
to the required schema level? Before you upgrade the database please 
make sure that all the clients are logged out of QADirector database.

If the schema of the QADirector database is newer than the client, the 
following message appears:

Current version of QADirector has schema version x whereas required 
schema version is x. Please use appropriate release of QADirector to 
work with this schema of the database or change datasource.

Note: To perform a migration you must be an Administrator. 

To upgrade and migrate from an Access database to an MSDE/SQL Server 
database:

Table 5-1. QADirector Filter Fields

4.5.1 05.00.01

QC_SUMMARY Summary

QC_NAME Name

QC_DEFECT_ID DefectIds

QC_EXP_RESULT ExpectedResult

QC_MANUAL IsManual

QC_CREATED_BY CreatedBy

QC_IS_CLASS IsClass

QC_IS_PROC IsProc

QC_RUN_IN_PARALLEL ParallelChildren
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1 Create a blank MSDE database to serve as the destination for the data 
in the 4.5.1 Access database after the migration is finished. Refer to 
the MSDE Help system for information.

2 Create an ODBC connection to both the blank MSDE database you 
just created and to the Access database from which you are migrat-
ing.

3 At the QADirector Log In screen, click the Configure... button to 
point to the Access database from which you will be migrating. The 
Select a Database dialog appears.

4 From the Data Source Type radio buttons, choose Access.

5 In the Data Source Name field, select the exact name of the Access 
Database/ODBC connection you created in step 2.

6 Click OK. The QADirector Log In screen appears. 

7 At the QADirector Log In screen, enter the User Name and Pass-
word.

8 Click OK. 

9 If necessary, click Yes to upgrade the database schema to the required 
schema level. The QADirector Data Migration Information dialog 
appears with the Datasoure Type, Datasoure Name, Database 
Name, and Schema/User Name fields filled in by default.

10 In the User Name and Password fields, enter the user name and 
password for the blank MSDE database you created in step 1.

11 Click Test to verify that the information provided is correct. A test 
confirmation dialog appears.

12 Click OK to acknowledge the successful test. The QADirector Data 
Migration Information dialog appears. 

13 Click Continue... to continue the upgrade process. The QADirector/
Portal Database Upgrade screen appears. 

14 Click Begin Upgrade. The Current Item Progress, Overall Progress, 
and Upgrade Item indicators will display the ongoing progress of the 
database migration.

15 When the upgrade is complete, click Close.

Note: If you plan to use QACenter Portal, refer to “Installing QACenter 
Portal on the Web Server” on page 27 for details.
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Migrating QACenter Portal
When migrating QACenter Portal 05.00 to QACenter Portal 05.00.01 
keep in mind the following:

1 Uninstall QACenter Portal 5.0. 

2 Uninstall OptimalView 3.2

3 Install QACenter Portal 5.0.1. See “Installing QACenter Portal” on 
page 27.

4 Configure QACenter Portal. See “Configuring QACenter Portal/
QADirector” on page 35.

5 Configure the database to QACenter Portal. Refer to Configuring the 
Database in the QACenter Portal online help.

Note: If prompted, continue with database upgrade.
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Chapter 6

Maintaining the Installation
� Accessing Maintenance Mode

� Modifying an Installation

� Repairing an Installation

� Uninstalling QADirector

� Uninstalling QACenter Portal

Accessing Maintenance Mode
To access QACenter products’ maintenance mode, Compuware recom-
mends using the Windows Control Panel.

Required: Compuware recommends that you exit all non-essential Windows 
programs before running this setup program. Some Windows 
programs may interfere with the installation process.

Accessing Maintenance Mode from the Windows Control 
Panel

1 Click the Windows Start button and choose Settings>Control Panel. 
The Control Panel dialog box appears.

2 Choose the Add/Remove Programs icon. The Add/Remove Pro-
grams dialog box appears. Select the QACenter product to maintain 
and click Change/Remove.

Three maintenance mode options display: modify, repair, and remove. 
For more information about these options, see the appropriate section in 
this chapter.
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Modifying an Installation
For products with optional components, you may want to add or remove 
a component. 

Rather than uninstall and re-install the product, you can modify your 
installation.

Modifying Products With Optional Components

1 Access maintenance mode described at the beginning of this chapter.

2 Select the Modify option. Click Next. The Select Components dia-
log box appears allowing you to add or remove components.

3 Click Next. Setup will add or remove the appropriate components.

4 After modifying, you may be prompted to restart your computer. If 
you are prompted to restart your computer, you may choose to restart 
it now (recommended) or to restart it later.

5 Click Finish to complete the maintenance.

Repairing an Installation
There may be times when you will need to repair a damaged QACenter 
product installation. This could be due to an inadvertent deletion or 
corruption of the program. To repair your QACenter product, follow 
these steps:

1 Access maintenance mode described at the beginning of this chapter.

2 Select the Repair option. Click Next. Setup will repair the specified 
QACenter product. 

3 After repairing, you may be prompted to restart your computer. If 
you are prompted to restart your computer, you may choose to restart 
it now (recommended) or to restart it later.

4 Click Finish to complete the maintenance.

Uninstalling QADirector
If you want to remove QADirector, follow these steps:
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1 Access maintenance mode described at the beginning of this chapter.

2 Select the Remove option. Click Next. The Confirm File Deletion 
dialog box appears. 

3 Click OK. Setup will remove QADirector from your PC. 

4 After uninstalling, you may be prompted to restart your computer. If 
you are prompted to restart your computer, you may choose to restart 
it now (recommended) or to restart it later.

5 Click Finish to complete the maintenance.

Uninstalling QACenter Portal 
Since QACenter Portal uses several different Compuware applications, 
there are special steps to take when removing the product.

To uninstall QACenter Portal:

Note: To ensure a clean removal of the applications, uninstall the products 
in the exact order described in these steps.

1 Disconnect from the database. Refer to “Disconnecting from the 
Database” on page 37.

2 Access maintenance mode described at the beginning of this chapter.

3 Uninstall OptimalView 3.2. 

4 Uninstall QACenter Portal 05.00.01.

5 Delete the QACenter Portal installation folder on the machine. For 
example, the folder may be located in x:\Program Files\Compu-
ware\QACenter Portal\.

Uninstalling the QACenter MSDE Instance
To remove the QACenter MSDE instance, follow these steps:

Caution: All associated data will be lost when you uninstall the MSDE 
instance.

1 Access maintenance mode described at the beginning of this chapter 
and remove the Microsoft SQL Server Desktop Engine (QACENTER). 

2 After uninstalling the MSDE database, some associated files may 
remain. Delete any remaining files from the installation directory.
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Appendix A

Manually Creating and 
Configuring a Database
� Manually Creating and Configuring an Oracle Database on 
the Database Server

� Manually Creating and Configuring a SQL Server Database

Manually Creating and Configuring an Oracle Database on the 
Database Server

This section provides information about configuring QADirector to use 
an Oracle database. 

Oracle Server Requirements

� An existing database server that runs the supported versions of Ora-
cle. Refer to “System Requirements” on page 14 for details.

� Oracle ODBC drivers for supported versions of Oracle. Refer to “Sys-
tem Requirements” on page 14 for details.

� A database instance set up on the Oracle database server to hold 
QADirector data. Use the following specifics to configure the data-
base instance:

� When the Oracle database instance is defined, you must specify 
the Storage Character Set as iso 8859-1 West European. 

� The NLS_LANGUAGE parameter should be set in the parameter file 
as:

NLS_LANGUAGE = 'AMERICAN'

If you are using Windows 2000, set the NLS_LANGUAGE 
parameter to AMERICAN_AMERICA.WE8ISO8859P1 in the 
following locations:
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BETA REVIEW
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES\IDO\NLS_LAN
G
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME-\NLS_LANG

� Access to a valid owner names (also known as a schemas) on the Ora-
cle database server for QADirector. This owner name is the user ID 
that will be associated with each of the product databases.

Creating Database Tables

Before any client machines can connect to the Oracle database, you must 
create the database and the database tables for QADirector. The SQL*Plus 
utility allows you to create the database tables. To create QADirector 
tables, perform the following for each database:

1 On the Oracle server or client machine, open SQL*Plus Worksheet. 
Click Start>Programs>Oracle (Oracle home name)>Database 
Administration>SQL*Plus Worksheet menu. In Windows XP, click 
the Start menu and choose All Programs>Oracle (Oracle home 
name)>Database Administration>SQL*Plus Worksheet.

2 Select Connect Directly to a Database.

3 Enter a user name in the Username field. This will be the name of 
the schema where the QADirector tables reside.

4 Enter a password in the Password field.

5 Enter the name of the service running the database in the Service 
field. 

6 On the database server from within SQL*Plus, click the Open File 
icon on the tool bar. The Open Local Script File dialog box appears.

7 Click the Look In list and browse to \Compuware\database\sql-
scripts\oracle on the installation CD.

8 Execute the following scripts for AQW in order:

� 1_orcl_qacenter.sql

� 2_orcl_procedures.sql

� 3_orcl_delete_procedures.sql

� 4_orcl_optimalview.sql

� 5_qacenter_appinserts.sql

� 6_orcl_qacenter_appupdates.sql

� 7_orcl_optimalview_appinserts.sql
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Manually Creating and Configuring a SQL Server Database
This section provides information about configuring QADirector to use a 
SQL Server database. 

SQL Server Requirements

� An existing database server that runs a supported version of SQL 
Server. Refer to “System Requirements” on page 14 for details.

� A database instance on the SQL Server database server to hold QADi-
rector data. Use the following specifics to configure the database 
instance:

� If you are using SQL Server 7.0 and the database instance is 
defined, you must specify code page 1252 and sort order 52 (also 
known as ISO 8859-1). 

� If you are using SQL Server 2000, specify the 
SQL_Latin1_General_CP1_C1_AS collation.

� A SQL Server user ID and password to allow the QADirector adminis-
trator to set up the database server. 

Creating Database Tables

Once you have created the database, you can create the QADirector 
database tables. QADirector includes files that execute scripts and 
automatically create the tables for you.

1 To start the SQL Server Query Analyzer, select SQL Server Query 
Analyzer from the Tools menu in the SQL Server Enterprise Manager.

2 Select the database from the DB drop down list.

3 Click File>Open. The Open Query File dialog box appears.

4 Click the Look In list and browse to Compuware\aqw\sql-
scripts\mssql on the installation CD.

5 Select one script at a time, click Open, and click the Run (green 
arrow) icon on the toolbar to run each script in the following order:

� 1_sql_qacenter.sql

� 2_sql_procedures.sql

� 3_sql_delete_procedures.sql

� 4_sql_optimalview.sql

� 5_qacenter_appinserts.sql
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� 6_sql_qacenter_appupdates.sql

� 7_sql_optimalview_appinserts.sql

Adding User Rights to the Database (optional)

Once the database and tables have been built, add users and give them 
access rights using SQL Server Enterprise Manager. Using SQL Server 
authentication login, create a new login ID and password specifically for 
SQL Server access. Use this option to create one convenient user name 
and password to access the QADirector database and have each QADirec-
tor user use the same user name and password to connect to the 
database. If preferred, create multiple SQL Server user names and 
passwords.

Note: The user name and password used to connect to the SQL Server 
database is not the same user name and password that is used to 
connect to QADirector.

To create a SQL Server authentication, follow these steps:

1 In the left pane of the SQL Server Enterprise Manager, expand the 
SQL Server Group, and expand the server machine name.

2 Expand Security.

3 Select the Add New User icon from the menu. The SQL Server Login 
Properties dialog box appears.

4 On the General tab, perform the following:

a Type a user name in the Name field (for example, QATeam).

b Select SQL Server Authentication.

c Type the password in the Password field.

d From the Database drop down menu, select the QADirector data-
base.

5 From the Database Access tab, permit the user to access the created 
database.

6 Set up roles and permissions for the Login account:

� Option A: Ensure the Login account has the db_owner role.
� Option B: Ensure all privileges on all QACenter database objects 

are granted to the newly created Login account. The following is 
a sample script for granting all privileges on all objects to a user.

Note: Compuware does not assume any responsibility for the use of this 
script.
USE <Database Name>

Go
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DECLARE @ExecSQL varchar(255)

Declare @User varchar(64)

Set @User = <Login Account>

DECLARE curGrants CURSOR FOR

SELECT ‘GRANT ALL ON’ + NAME + ‘TP’ + rtrim(@User)

From SYSOBJECTS

WHERE TYPE = ‘U’ or TYPE = “P”

OPEN curGrants

FETCH NEXT FROM curGrants INTO @ExecSQL

WHILE @@FETCH_STATUS = 0

BEGIN

Exec(@ExecSQL)

FETCH NEXT FROM curGrants INTO @ExecSQL

END

CLOSE curGrants

DEALLOCATE curGrants

Installing the TrackRecord database

1 Install TrackRecord. Refer to the TrackRecord Installation and Configu-
ration Guide.

Note: The following steps apply to TrackRecord release 06.02.01.

2 On the database server, locate the directory where TrackRecord is 
installed (for example, C:\Program Files\Compuware\Track-
Record).

3 Open the \databases directory inside the \TrackRecord directory.

4 Inside the \databases directory, create a directory and give it the 
name you want to call the new TrackRecord database, for example 
QADirector.

5 On the installation CD-ROM for QADirector, locate the directory 
\cpwr\trdb.

6 Locate the file aqwtrdb.exe within \cpwr\trdb and double-click it. 
A dialog box appears so you can extract the files from this archive.

7 In the Unzip to Folder field, specify the TrackRecord database folder 
created in step 4 (for example, C:\Program Files\Compu-
ware\TrackRecord\databases\QADirector). If necessary, click 
Browse to locate the folder.

8 Click Unzip to copy the extracted files into the TrackRecord database 
folder.
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To access the new TrackRecord database, enter the database name 
(specified in step 4) in the Database field of the Login dialog box when 
you start TrackRecord. The client installation must be connected to the 
database server on which you created the TrackRecord database.
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Appendix B

Setting Up an ODBC DataSource
� Setting up an ODBC Data Source for Oracle

� Setting up an ODBC Data Source for SQL Server

Setting up an ODBC Data Source for Oracle

Creating an Oracle Net 8 Service Name

To create a Net 8 service name:

1 Open the Net Configuration Assistant. 

2 Select Local Net Service Name Configuration. 

3 Click Next.

4 Select Add and click Next. 

5 Select 8i Database or Service, and click Next. 

6 Type a service name in the Service Name (Instance Name or Data-
base Name) field. Click Next.

7 Select Communication Protocol (TCP), and click Next. 

8 Type a server name in the Host Name field. 

9 Validate the Port number (host: 1521), and click Next. 

10 Select Yes to perform a test. Click Next. 

11 Validate the test results. If the Test fails, fix the errors and retest.

12 Click Next. 

13 Type a Net service name in the Net Service Name field and click 
Next. 
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14 Click Finish.

Creating a Windows DSN

To set up an ODBC data source from the QADirector client machine, 
follow these steps:

Note: Compuware recommends that you use the Oracle driver instead of 
the Microsoft driver when connecting to the QADirector database.

1 In Windows 2000, click the Start menu, and select Settings>Control 
Panel>Data Sources (ODBC). The ODBC Data Source Administrator 
opens. Click the Drivers tab and select Oracle ODBC Driver.

If using Windows XP, select Control Panel>Administrative 
Tools>Data Sources (ODBC). The ODBC Data Source Administra-
tor opens. Click the Drivers tab and select Oracle ODBC Driver.

2 Click the System DSN tab.

3 Click Add.

4 Select Oracle from the Driver list.

5 Click Finish. The Create a New Data Source dialog box appears.

6 Enter a Data Source Name (DSN) in the Data Source Name field.

7 Enter a description in the Description field.

8 Enter the database service name in the Service Name field. 

9 Enter the user name in the UserID field.

10 Keep the default settings in the remaining fields and click OK.

Setting up an ODBC Data Source for SQL Server
To set up an ODBC data source:

1 In Windows 2000, click the Start menu, and select Settings>Control 
Panel. Double click the Data Sources (ODBC) icon. The ODBC Data 
Source Administrator opens.

In Windows XP, click the Start menu and select Control 
Panel>Administrative Tools>Data Sources (ODBC). Skip to step 3.

2 Click the System DSN tab.

3 Click Add.

4 Select SQL Server from the Driver list.
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5 Click Finish. The Create a New Data Source to SQL Server dialog 
box appears.

6 Enter an ODBC connection name in the Name field.

7 Enter a description for the ODBC connection in the Description 
field.

8 Enter the server name in the Server field.

9 Click Next.

10 Select the With SQL Server Authentication using a login ID and 
password entered by a user option.

11 Type a user name in the Login field.

12 Type a password in the Password field.

13 Click Client Configure.

14 Verify that TCP/IP is selected under the network libraries.

15 Click OK.

16 Click Next.

17 Select the Change the Default Database to checkbox.

18 Select the default database that you are configuring from the drop 
down menu.

19 Click Next.

20 Click Finish. The ODBC Microsoft SQL Server Setup dialog box 
appears.

21 Click Test Datasource.

22 Click OK to exit the ODBC Microsoft SQL Server Setup dialog box.

23 Click OK to exit the ODBC Data Source Administrator.
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